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Getting Started
Introduction
This manual provides instructions on how to use the Case Management/Electronic Case Filing (CM/ECF) system to file, view and retrieve documents for all cases assigned to this system.  Users should have a working knowledge of internet browsers and portable document format (.pdf) software.  Users who routinely save documents to a hard drive or network should also have an understanding of basic navigation tools and file structure.
Training
The Office of the Clerk offers CM/ECF training at no cost to attorneys, paralegals, secretaries and other professionals in the Southern District of Georgia.
To get started with training, please visit the Court’s website at www.gasb.uscourts.gov and click CM/ECF Info.

System Requirements
To view system requirements, please visit the Court’s website at www.gasb.uscourts.gov and click CM/ECF Info.

Registration Requirements
ECF Registration – Request for Login and Password
Participants requesting to file electronically using CM/ECF must register with the Court to receive a user name and password for the system.  Users may register by accessing the registration process located on the Court’s website at www.gasb.uscourts.gov and clicking CM/ECF Info > CM/ECF Registration Information.  
Attorneys applying for full access must first be admitted to practice in the Southern District of Georgia.  Admission status will be verified with the U.S. District Court for the Southern District of Georgia using the last name and Bar ID provided.  If admission cannot be verified, the application will not be approved.

PACER Registration
ECF users must have a PACER account to use the Query and Report features of the CM/ECF system.  If you do not have a PACER login, contact the PACER Service Center at 1-800-676-6856 or 1-210-301-6440 to establish an account.  You may also register for PACER online at www.Pacer.gov.

Accessing CM/ECF
STEP 1	CM/ECF is accessible through the Court’s website at www.gasb.uscourts.gov.  Select CM/ECF Info > Login – CM/ECF.  Users may also access CM/ECF through the Court’s website by clicking the link “E-Filing (CM/ECF)” on the left side of the screen. The following information will appear on the screen:
                         [image: C:\Users\lcasalin\Desktop\pacer login screenshot.bmp] 
STEP 2		Logins and Passwords
Filing users will have two sets of logins and passwords--one for CM/ECF filing, and the other for Public Access to Electronic Records (PACER) access for queries and reports.  Note: Once this court implements the Next Generation of CM/ECF, users will have one central sign-on account to access CM/ECF and PACER.  



Understanding the CM/ECF Menu Bar
The blue bar across the top of the CM/ECF screen is the MENU BAR.  The menu bar contains links for accessing different categories of functions and events used for filing and viewing documents.  
[image: ]
BANKRUPTCY 	
The BANKRUPTCY button contains links to the events for filing documents in bankruptcy cases, submitting proposed orders, and creditor maintenance.  The links are divided by category.  Clicking on the individual categories will open a “pick list” of events for the user to select. 
ADVERSARY 
The ADVERSARY button contains links to most of the events for filing documents in adversary proceedings.  The links are divided by category.  Clicking on the individual categories will open a “pick list” of events for the user to select. 
QUERY 
The QUERY button contains fields for the user to search for case information, such as copies of documents filed (in .pdf format), case status, deadlines, notices of electronic filing, parties, and information on the filer.  Enter the name or case number to open a list of information available to the user.  Please note that clicking on QUERY may open a separate screen for you to enter your PACER login and password before continuing.

REPORTS 
The REPORTS button contains links for the user to create and print a variety of reports.  This includes reports on cases filed in the district, docket activity reports, and claims register.  A user can also print copies of documents filed in a case. Please note that clicking on REPORTS may open a separate screen for you to enter your PACER login and password before continuing.
UTILITIES 
The UTILITIES button contains a list of utilities to change your ECF login and password, change your address or telephone number, and view a log of your transactions.  It can also be used as an alternate method to make filing fee payments.  Options under this heading may vary depending on access rights.
SEARCH 
The SEARCH button enables a user to search for the location of filing events for filing documents in CM/ECF.  This is a very helpful key word search and allows users to file directly from the list that is generated.
LOGOUT 
The LOGOUT button allows the user to log off the ECF system.  It is important that you log off the system when you are finished.  Failing to properly log off the system may cause an error message when trying to log in at a later time. 
HELP 
The HELP button (yellow question mark) opens a new window containing a brief description and function of each category on the menu bar.

Case Query
A query is a way to search Court records by case number, party name, social security number, or tax ID.  Registered CM/ECF users with a CM/ECF login may file documents and run queries and reports.  The public, through a PACER account, can access queries and reports.  It is important to query a case before docketing a pleading to make sure the case is still open.
To run a query:
Select Query from the CM/ECF menu bar > Enter PACER Login and Password > Enter search clues (i.e., case number, last name, etc.) > Click “Run Query”:
[image: ]
From this screen, users can click Case Summary to find the case file date, dismissal date, closing date, etc.  Another useful tool accessible from this screen is the Docket Report... 

Preparing for Electronic Filing
Clearing the Cache
CM/ECF is a web-based software program.  Users access CM/ECF through a web browser.  In order for information to be displayed properly in CM/ECF, it is necessary to clear the “cache” or temporary memory that is stored on your computer.  Web browsers cache or store information from the web sites you visit, to increase the speed at which internet pages are accessed; however, one side effect is that pages displayed from the cache may not be as new as pages available from the web.  This means that you may not see updates that are made in CM/ECF unless you clear the browser cache.  The cache should be cleared frequently to avoid errors.
To clear your cache using Internet Explorer 8.0, follow these steps:
· Open Internet Explorer
· Select TOOLS option from the menu bar
· Select INTERNET OPTIONS
· Under “Browsing History,” click on DELETE
· Select “Temporary Internet files” check box
· You may also want to remove additional stored data such as form data, passwords, cookies and history; however, it is not required.
· Click DELETE
· Click OK to complete the process and return to your browser
Other web browsers (Netscape, Mozilla Firefox, etc.) will also have processes to clear the temporary internet memory.  The features for those browsers will usually be located in the “Tools” menu.
Allowing Pop-Up Screens
The presence of an active “pop-up blocker” may interfere with the use of the Court’s payment window in CM/ECF.  Depending on the type of pop-up blocker present, the user may have to either modify the pop-up blocker to allow pop-ups from the Court, or disable the pop-up blocker.  Here are a few examples for commonly used pop-up blockers:
Allowing pop-up screen using Internet Explorer 8.0 or higher
· Open Internet Explorer
· Select TOOLS option from the menu bar
· Select Pop-Up Blocker
· Select “Turn Off” Pop-Up Blocker
Allowing pop-up screen using Mozilla Firefox
· Open Firefox
· Select TOOLS option from the menu bar
· Select OPTIONS from the drop-down menu
· Select the Web Features Icon
· Select Allowed Sites
· Type uscourts.gov in the “Address of web site” field and click Allow
· Click OK
· Click OK to complete the process and return to the browser.
Allowing pop-up screen using Internet Google Tool Bar
· Open browser
· Select OPTIONS from the Google toolbar
· In Accessories, uncheck “Popup Blocker.”
· Click OK to complete the process and return to the browser.
Allowing pop-up screen using Internet Yahoo Tool Bar
· Open browser
· Click on the Pop-Up Blocker icon from the Yahoo toolbar
· Select “Always Allow Pop-Ups From…” from the drop-down menu
· Highlight the site name (uscourts.gov) in the “Sources of Recently Blocked Pop-Ups” field and click Allow
· Click OK
· Click Close to complete the process and return to the browser.
Converting Documents to PDF
Adobe Acrobat Versions
Adobe Acrobat Version 4.0 or later is necessary for the creation of PDF files.  It may be purchased online or at any computer store.  Adobe Acrobat Reader is all that is necessary if only reading PDF files.  This can be downloaded for free at www.adobe.com. 
Document Considerations
Documents should be prepared from a word processing program if possible.  Larger files take longer to transmit, download, and view.  PDF files should be no more than 35 megabytes (MBs).  To check the file size of a document, right-click on the file (while in browse), and click on “Properties.”  Note that 1 MB is equal to 1,000 KBs.  Larger files may be separated into multiple files as per the instructions below.  When working with a document, usually all of the sections are maintained in that single document (except for the Certificate of Service).  The easiest way to separate the document into multiple PDF files is to print page ranges of the document to Adobe Acrobat PDF Writer/Adobe PDF.  Exhibits, Proposed Orders, and Certificates of Service may be submitted as attachments to the main document.  If scanning the document, scan each section separately.  Delete items from the scanner database when finished; too many scanned files will quickly fill any remaining disk space.
Manual Transmission of Documents
There are various acceptable forms of media.  Please refer to the Court’s CM/ECF Administrative Procedures for more information.
Scanning Guidelines
Following these scanning guidelines will minimize file size and save storage space.  It is critical to the efficient use of CM/ECF that the software used for scanning documents is configured correctly.  Incorrect or incomplete setup will cause a significantly increased file size – typically 20 to 40 times larger.  This larger file size causes:
· Vastly increased file storage requirements at the user’s PC, server, and backup level, together with a general slowness in processing such files;
· Vastly increased network traffic, both locally and through the user’s Internet Service Provider, with very long file upload times.  Files may simply be rejected for size, or the communications work may time out due to oversized files;
· A very slow response from CM/ECF, as the user attempts to upload a large file, and attendant delay in obtaining a confirmation of successful receipt, or at worst, file rejection.
· A very slow download and file opening, when attempting to read large files already uploaded into CM/ECF.
Fortunately, there are some easy steps and checks to ensure correct scanner software settings:
· Resolution should be set to 300 dpi
· Image type should be set to black and white drawing (NOT gray scale or color). 
· Scanned image output or save as format should be TIF (ideally compressed CCITT4).  Check your scanner software manual or Help for information on how to set output type.
A simple test scan should be conducted, and the file converted to PDF for upload to CM/ECF.  This PDF conversion can be done using one of several software packages; a good example is Adobe Acrobat 5.0 (full package, not just Reader).  Drag the scanned file onto the Acrobat icon, and conversion is automatic.  This conversion should not significantly increase the file size - perform a final check of the PDF to make sure.  File size can be viewed by locating the file through Windows Explorer, left-clicking the icon of the file once to highlight it, then right-clicking and selecting Properties.  The file size will appear.
If the document is mostly text, it should be no larger than approximately 50KB per page.  At the most, a very detailed page with graphics (e.g. a title) should be no larger than approximately 200KB per page. 
To create a PDF file from a Microsoft Word Document:
· Adobe Acrobat PDF Writer must be installed to create a PDF file.
· Open the document in MS Word, and finalize any edits/changes.
· Select File > Print
· Change the printer option to “Acrobat PDF Writer/Adobe PDF” and click Print
· When prompted for the file designation, save the file in a designated case folder, or change the drop-down window to reflect the storage device (USB flash drive, etc.)
· Use an easily identifiable file name which incorporates the case number and type of pleading (i.e., 14-41124 Obj. to Claim).
· Click Save
To create a PDF file from a WordPerfect 12 Document:
· Adobe Acrobat PDF Writer or Adobe Distiller is not required to create a PDF file
· Open the document in WordPerfect, and finalize any edits/changes.
· Select File > Publish to PDF
· Click the Browse button and choose the drive where the file is to be saved
· Double-click the folder in which the file is to be saved
· Type the file name in the File Name box; use an easily identifiable file name which incorporates the case number and type of pleading (i.e., 14-41124 Obj. to Claim).
· Click OK
To create a PDF file from other Word Processing Program:
· Adobe Acrobat PDF Writer must be installed to create a PDF file.
· Open the document in the word processing program, and finalize any edits/changes.
· Select File > Print
· Change the printer option to “Acrobat PDF Writer/Adobe PDF” and click Print
· When prompted for the file designation, save the file in a designated case folder, or change the drop-down window to reflect the storage device (USB flash drive, etc.)
· Use an easily identifiable file name which incorporates the case number and type of pleading (i.e., 14-41124 Obj. to Claim).
· Click Save
To create a PDF file using a Scanner Program:
· If not already running, open the scanner program on your computer.  A scanner icon may be displayed on the Taskbar.  If it is not, choose: Start > Programs > Name of Scanner Program, and click to run.  Once started, the scanner window can be minimized.
· Scan the document by following the instructions specific to the scanner.
· When scanning is complete, retrieve the file by clicking on it.
· To send to the printer, select File > Print from the menu (or click and drag to the printer icon)
· Change the printer option to “Acrobat PDF Writer/Adobe PDF” and click Print
· When prompted for the file designation, save the file in a designated case folder, or change the drop-down window to reflect the storage device (USB flash drive, etc.)
· Use an easily identifiable file name which incorporates the case number and type of pleading (i.e., 14-41124 Obj. to Claim).
· Click Save
· Close and exit the scanner software and/or the scanner utility program.

Style Guide
The intention of these style guidelines is to assist in the standardization of data entry into CM/ECF by all users.  Application of a common set of styles when creating docket entries results in information being captured and displayed in more uniform and predictable ways, thus reducing confusion and errors.  In addition, style consistency is the key to efficient searches in CM/ECF, since successful queries require very exact matches on search data including punctuation, abbreviations, and upper or lower case.
**Always perform a search/query in the CM/ECF database for a party before adding them to a case.  If the system finds/displays the name and address of the person/entity needed, select it to help eliminate different versions of the same party name. If the name is correct but the address differs, accept the displayed record and modify the address.
Debtor Name
· Add debtors to cases using names and addresses exactly as they appear on the petition or complaint.
· If a search for the debtor’s social security number or name displays the name you are looking for, accept it; if the address is different, change it on the debtor screen when opening the petition.
· If the name includes a hyphen, do not use a space before and/or after the hyphen.
· If the last name includes more than one capital letter, such as “DeCosta,” enter it as shown.  Do not type a space between the e and the C.
· If an alias is included, list as follows:  John Henry, a/k/a John P. Henry, a/k/a John Paul Henry.
Phone/Fax Numbers
· Phone and fax numbers should be entered with parentheses around the area code.  Example:  (912)650-4100, not 912/650/4100
Business Names
· Enter small words that precede business names, such as The, A, An, etc., at the end of the business name, with a comma separating the two.  Example:  Franklin Hotel, The
· When a business name is listed in a format that is slightly different than a standard name in the database, create a new party record.  For example, if Aetna Casualty Insurance Company has filed a pleading, and upon searching only Aetna Casualty Co. is found, create a new party record.

Attorney Names, Bar Codes, Firm Names and Addresses
· Avoid using commas between partner names, and insert a space before and after the ampersand (&) if the address includes one.
· Avoid using the word “The” to precede firm names.  For example, The Law Office of Hamel, Wexler & Collins should be listed as Law Office of Hamel Wexler & Collins.  If there is not enough space to type the complete firm name on the first address line, type “et al” at the end of the line.
· If an attorney has more than one address, upon searching, the attorney’s name should appear twice in the pick list; choose one – if not correct, choose the other.  If the address appearing is still not correct, add the attorney with the correct address and submit an attorney role sheet.
· When adding a creditor c/o an attorney, do not use any symbols, if possible; if not, leave a space before and after an ampersand (&), and instead of using “c/o Attorney” add the attorney’s name.  The Bankruptcy Noticing Center (BNC) views “c/o” as a percentage sign (%) in many cases, and symbols count for at least 40 characters when they should only be considered one.
General Style Rules 
· Please refer to Appendix B for a list of common abbreviations and designations.
· When typing last names that begin with “Mc” or “De,” type with proper capitalization:  McCormick, not Mc Cormick, MCCormick, or MCCORMICK.
· If the last name is hyphenated, type it with the hyphen, leaving no space in between.
· Abbreviate words in the address; do not type them out.  Example:  St, Ave, Blvd, Apt
· When adding a name that contains the word The, A, or An, place it at the end of the name, preceded by a comma.
· Standard abbreviations:
P O Box (not P.O. Box or P. O. Box)
GA (not G.A. or G A)

Filing a Proof of Claim/Claim Actions
Filing a Proof of Claim
When a proof of claim is filed in CM/ECF, the claim will be attached to the creditor record of the claimant.  Query the case to be certain the case is open, and also query the case deadlines to see if the deadline to file claims has expired.  If the claims bar date has passed, a Motion to Allow/Reconsider Claim or File Claim After Claims Bar Date must be filed.
Locate the creditor by searching the creditor database.  Most often the creditor filing the claim already exists in the creditor database.
ePOC Program: Electronic Proof of Claims (ePOC) is a program designed to streamline claims processing by allowing creditors to file a claim, amend a claim, withdraw a claim, or supplement a claim via the internet without having to log into CM/ECF.  The ePOC program will automatically prepare an official Bankruptcy Proof of Claim form (Form 410) that is pre-populated based on the information entered into the program.  Benefits of the program to creditors include ease of using the ePOC program and instant confirmation of action, as well as instantaneous filing of the claim in CM/ECF.
Filing a Proof of Claim using ePOC (Electronic Proof of Claim Program)
The ePOC program is located on the Court’s website at www.gasb.uscourts.gov.  Click the “Electronic Claims (ePOC)” link.
· Type in case number
· Select the appropriate filer type from the drop-down menu
· Check the box next to “I understand that, if I file, I must comply with the redaction rules.  I have read this notice.”
· Click Next
· If Creditor Attorney was selected, enter the attorney’s name and address
· Click Next
· Select creditor, making sure that the address is what should be reflected on the proof of claim; otherwise, select the radio button next to “Creditor not listed.”
· If adding a new creditor/address, type the correct address for the creditor, to be reflected on the proof of claim.
· All Yes/No questions on the form must be answered
· Enter information in all required fields
· Do not upload a completed Proof of Claim form as an attachment to this filing.  Attaching a completed Proof of Claim will result in multiple versions of the form being filed.
· Note: you will have the option to select files/documents to upload for this claim once you click on the “Submit Claim” button
· Type full name and contact information, then enter the verification code.
· Click Submit Claim
· If you wish to view/print your filed claim, click on the hyperlink displaying the claim number.
Filing an Amended Proof of Claim using ePOC (Electronic Proof of Claim Program)
The ePOC program is located on the Court’s website at www.gasb.uscourts.gov.  Click the “Electronic Claims (ePOC)” link.
· Type in case number
· Select the appropriate filer type from the drop-down menu
· Check the box next to “I understand that, if I file, I must comply with the redaction rules.  I have read this notice.”
· Click Next
· If Creditor Attorney was selected, enter the attorney’s name and address
· Click Next
· Select creditor, making sure that the address is what should be reflected on the proof of claim; otherwise, select the radio button next to “Creditor not listed.”
· If adding a new creditor/address, type the correct address for the creditor, to be reflected on the proof of claim.
· All Yes/No questions on the form must be answered
· Enter information in all required fields
· Select Yes to Question 4: “Does this claim amend one already filed?”  Select the claim number from the drop-down menu.  The filing date will be entered automatically.
· Do not upload a completed Proof of Claim form as an attachment to this filing.  Attaching a completed Proof of Claim will result in multiple versions of the form being filed.
· Note: you will have the option to select files/documents to upload for this claim once you click on the “Submit Claim” button
· Type full name and contact information, then enter the verification code.
· Click Submit Claim
· If you wish to view/print your filed claim, click on the hyperlink displaying the claim number.
Filing Withdrawal of Claim using ePOC (Electronic Proof of Claim Program)
The ePOC program is located on the Court’s website at www.gasb.uscourts.gov.  Click the “Electronic Claims (ePOC)” button.
· Type in case number
· Select the appropriate filer type from the drop-down menu
· Check the box next to “I understand that, if I file, I must comply with the redaction rules.  I have read this notice.”
· Click Next
· Check the box next to the claim to be withdrawn
· Attach PDF by clicking on the Browse button
· Locate pdf document and right-click to open
· Click on Open button
· Enter the verification code
· Click “Submit Withdrawal of Claim”
· If you wish to view/print the withdrawal, click on the hyperlink displaying the docket number.
Claims Filing in CM/ECF
Docketing a Proof of Claim in CM/ECF:
· Select Bankruptcy
· Select File Claims
· The Search for Creditor screen will appear.  Enter the case number, and click Next to search the creditor database for the claimant.
· The Creditor Selection screen will display the creditor(s).  Click on the drop-down arrow to display all of the creditors.  Select the appropriate creditor, making sure that the creditor’s name and address match exactly what is listed on the proof of claim, by clicking on it.  If unable to locate the creditor after using different search criteria, click the Add Creditor hyperlink to add the creditor to the case.  After adding the creditor, click Next.
· Click Submit.  A creditor receipt will appear, indicating the creditor has been added.
· Click the link to FILE A PROOF OF CLAIM.
· When the Search for Creditor screen reappears, enter the case number (if necessary) and click Next.
· The Creditor Selection screen will appear.  Click on the drop-down arrow to display all of the creditors.  Select the appropriate creditor by clicking on it.  If pop-up blockers are off, a screen will appear that states whether a claim has already been filed for that creditor and address, or if there are no claims filed for the case, asking if the creditor is correct.  Click the Yes button to proceed.
· The Proof of Claim Information screen will display.
· Enter the data in the appropriate fields for the claim, showing total amount claimed, secured amount, priority amount, etc.  Do not use $ or commas in the dollar amount fields. Values default to whole dollars.  Decimals are accepted, but not required.
· In the Filed By field, choose the filer type from the drop-down box: Creditor
· Enter information in the Description and/or Remarks fields as appropriate.  No more than 255 characters may be typed into these fields.
· Click Next.
· Attach PDF by clicking on the Browse button
· Locate pdf document and right-click to open
· Click on Open button
· Click Next
· A message will appear: Attention! Submitting this screen commits this transaction.  You will have no further opportunity to modify this submission if you continue.  Have you redacted?  Click Next.
· The Notice of Electronic Claims Filing will display.  The claim is now part of the official Court record.  Clicking on the case number hyperlink will present the case docket report.  Clicking on the document number hyperlink will display a pdf image of the claim.  Clicking on the Claims Register hyperlink will display the claims register.
· To continue claims processing, click link to File another claim.  The prior case number will be preserved for further claim entries to the same case.  For a new case, enter the new case number and repeat the process above.
Amended Proof of Claim
Go to Reports > Claims Register > Run Report.  View a list of claims filed, to determine which claim to amend.
To file an amended claim through CM/ECF, follow the instructions above for filing a proof of claim.  In the “amends claim #” field, enter the number of the claim that is being amended and click “Find.”  Select the claim to be amended.  Enter the amended claim information (amount, etc.).  The amended information will be reflected in the original and amended claim on the claims register.
Note: if the address has changed since the original claim was filed, add the new creditor address and select the claim being amended when clicking on the “Find” button to amend.  A screen will appear with the old and new address – select Continue.
Creditor Maintenance/Adding a Creditor Address
· Select Bankruptcy
· Select Creditor Maintenance
· Select Enter Individual Creditors
· Enter the case number (yy-nnnnn)
· Click Next
· Enter the creditor’s name and address
· NOTE:  more than one creditor may be entered; separate creditors with a blank line.
· Click Next
· Click Submit
Withdrawal of Proof of Claim (via CM/ECF)
· Select Bankruptcy
· Select Limited Miscellaneous Events
· Type in case number
· Click Next
· Select Withdrawal of Claim
· Click Next
· Click Next
· Select attorney filing pleading or leave as is and click Next
· Select party filing pleading or Add/Create New Party
· Click Next
· Attach PDF by clicking on the Browse button
· Locate pdf document and right-click to open
· Click on Open button
· Click Next
· Select Claim Number(s) from list
· Click Next
· Select Claim Status (Withdraw)
· Click Next
· Click Next
· Final Docket Text appears.  Click Next ONLY if correct.  If incorrect, click the Back button at the top of the browser screen to make the correction, or abort/restart the transaction by clicking on the Bankruptcy Events hyperlink.
· Notice of Electronic Filing screen will appear.
· NOTE:  Withdrawals of Claims will appear on the claims register.
Transfer/Assignment of Claim
Filing Requirements:  Transfer/Assignment, $25 filing fee
· Select Bankruptcy
· Select Limited Miscellaneous Events
· Type in case number
· Click Next
· Select Transfer of Claim - Fee
· Click Next
· Click Next
· Select attorney filing pleading or leave as is and click Next
· Select party filing pleading or Add/Create New Party
· Click Next
· Attach PDF by clicking on the Browse button
· Locate pdf document and right-click to open
· Click on Open button
· Click Next
· Select transfer type
· Click Search Creditors button to search for transferee.  If the creditor cannot be located, click Add New Creditor.  If adding a new creditor, type in the information and click Submit.
· Click Search Creditors button to search for transferor.  Select the creditor from the scroll-down menu and click Select.  The claim number should appear next to the creditor selected.
· Click Next
· Filing fee defaults to $25
· Click Next
· Click Next
· Final Docket Text appears.  Click Next ONLY if correct.  If incorrect, click the Back button at the top of the browser screen to make the correction, or abort/restart the transaction by clicking on the Bankruptcy Events hyperlink.
· Notice of Electronic Filing screen will appear.
· NOTE:  Transfers of Claims will appear on the claims register.
Objection to Transfer of Claim
· Select Bankruptcy
· Select Limited Miscellaneous Events
· Type in case number
· Click Next
· Select Objection to Transfer of Claim
· Click Next
· Click Next 
· Select attorney filing pleading or leave as is and click Next
· Select party filing pleading or Add/Create New Party
· Click Next
· Attach PDF by clicking on the Browse button
· Locate pdf document and right-click to open
· Click on Open button
· Click Next
· Click check box to refer to existing event(s)
· Click Next
· Select the appropriate event(s) to which your objection relates
· Click Next
· Click Next
· Final Docket Text appears.  Click Next ONLY if correct.  If incorrect, click the Back button at the top of the browser screen to make the correction, or abort/restart the transaction by clicking on the Bankruptcy Events hyperlink.
· Notice of Electronic Filing screen will appear.
Withdrawal of Transfer of Claim
· Select Bankruptcy
· Select Limited Miscellaneous Events
· Type in case number
· Click Next
· Select Withdrawal of Transfer of Claim
· Click Next
· Click Next
· Select attorney filing pleading or leave as is and click Next
· Select party filing pleading or Add/Create New Party
· Click Next
· Attach PDF by clicking on the Browse button
· Locate pdf document and right-click to open
· Click on Open button
· Click Next
· Check the box next to the transfer of claim being withdrawn
· Click Next
· Click Next
· Final Docket Text appears.  Click Next ONLY if correct.  If incorrect, click the Back button at the top of the browser screen to make the correction, or abort/restart the transaction by clicking on the Bankruptcy Events hyperlink.
· Notice of Electronic Filing screen will appear.

Notice of Mortgage Payment Change
· Select Bankruptcy
· Select Limited Miscellaneous Events
· Type in case number
· Click Next
· Select Notice of Mortgage Payment Change
· Click Next
· Click Next 
· Select attorney filing pleading or leave as is and click Next
· Select party filing pleading or Add/Create New Party
· Click Next
· Note: no document number will be assigned
· Attach PDF by clicking on the Browse button
· Locate pdf document and right-click to open
· Click on Open button
· Click Next
· Select claim(s) from list and click Next
· A Certificate of Service must be included or attached to the document currently being filed – select Yes if attached.
· Click Next
· Modify docket text, if appropriate.
· Click Next
· Final Docket Text appears.  Click Next ONLY if correct.  If incorrect, click the Back button at the top of the browser screen to make the correction, or abort/restart the transaction by clicking on the Bankruptcy Events hyperlink.
· Notice of Electronic Filing screen will appear.
· NOTE:  A Notice of Mortgage Payment Change will appear on the claims register, if a proof of claim has been filed.
Notice of Postpetition Mortgage Fees, Expenses and Charges
· Select Bankruptcy
· Select Limited Miscellaneous Events
· Type in case number
· Click Next
· Select Notice of Postpetition Mortgage Fees, Expenses, and Charges
· Click Next
· Click Next 
· Select attorney filing pleading or leave as is and click Next
· Select party filing pleading or Add/Create New Party
· Click Next
· Note: no document number will be assigned
· Attach PDF by clicking on the Browse button
· Locate pdf document and right-click to open
· Click on Open button
· Click Next
· Select claim(s) from list and click Next
· A Certificate of Service must be included or attached to the document currently being filed – select Yes if attached.
· Click Next
· Modify docket text, if appropriate.
· Click Next
· Final Docket Text appears.  Click Next ONLY if correct.  If incorrect, click the Back button at the top of the browser screen to make the correction, or abort/restart the transaction by clicking on the Bankruptcy Events hyperlink.
· Notice of Electronic Filing screen will appear.
· NOTE:  A Notice of Postpetition Mortgage Fees, Expenses, and Charges will appear on the claims register, if a proof of claim has been filed.
Response to Notice of Final Cure Payment Rule 3002.1
· Select Bankruptcy
· Select Limited Miscellaneous Events
· Type in case number
· Click Next
· Select Response to Notice of Final Cure Payment Rule 3002.1
· Click Next
· Click Next 
· Select attorney filing pleading or leave as is and click Next
· Select party filing pleading or Add/Create New Party
· Click Next
· Note: no document number will be assigned
· Attach PDF by clicking on the Browse button
· Locate pdf document and right-click to open
· Click on Open button
· Click Next
· Select claim(s) from list and click Next
· A Certificate of Service must be included or attached to the document currently being filed – select Yes if attached.
· Click Next
· Modify docket text, if appropriate.
· Click Next
· Final Docket Text appears.  Click Next ONLY if correct.  If incorrect, click the Back button at the top of the browser screen to make the correction, or abort/restart the transaction by clicking on the Bankruptcy Events hyperlink.
· Notice of Electronic Filing screen will appear.
Withdrawal of Rule 3002.1 Document
· Select Bankruptcy
· Select Limited Miscellaneous Events
· Type in case number
· Click Next
· Select Withdrawal of Rule 3002.1 Document
· Click Next
· Click Next 
· Select attorney filing pleading or leave as is and click Next
· Select party filing pleading or Add/Create New Party
· Click Next
· Select the Filing to which this Withdrawal Refers and click Next
· Is this Withdrawal being filed in regards to Bankruptcy 3002.1(b), where a corresponding Proof of Claim has been filed?  Select Yes or No
· Click Next
· Attach PDF by clicking on the Browse button
· Locate pdf document and right-click to open
· Click on Open button
· Click Next
· Select claim(s) from list and click Next
· Click check box to relate the withdrawal to the document being withdrawn
· Click Next
· Modify docket text as appropriate, and click Next
· Final Docket Text appears.  Click Next ONLY if correct.  If incorrect, click the Back button at the top of the browser screen to make the correction, or abort/restart the transaction by clicking on the Bankruptcy Events hyperlink.
· Notice of Electronic Filing screen will appear.

Miscellaneous Pleadings/Docket Events
Change of Address 
· Select Bankruptcy
· Select Limited Miscellaneous Events
· Type in case number
· Click Next
· Select Notice of Change of Address
· Click Next
· Click Next 
· Select attorney filing pleading or leave as is and click Next
· Select party filing pleading or Add/Create New Party
· Click Next
· Click Next
· Is this notice being filed in lieu of a transfer of claim pursuant to Bankruptcy Rule 3001(e)?  Select Yes or No
· Click Next
· Attach PDF by clicking on the Browse button
· Locate pdf document and right-click to open
· Click on Open button
· Click Next
· Enter name of party or parties whose address is changing
· Click Next
· Modify docket text, if appropriate.  Click Next.
· Final Docket Text appears.  Click Next ONLY if correct.  If incorrect, click the Back button at the top of the browser screen to make the correction, or abort/restart the transaction by clicking on the Bankruptcy Events hyperlink.
· Notice of Electronic Filing screen will appear.
Notice of Appearance and Request for Notice
· Select Bankruptcy
· Select Limited Miscellaneous Events
· Type in case number
· Click Next
· Select Notice of Appearance and Request for Notice
· Click Next
· Click Next 
· Select attorney filing pleading or leave as is and click Next
· Select party filing pleading or Add/Create New Party
· Click Next
· Attach PDF by clicking on the Browse button
· Locate pdf document and right-click to open
· Click on Open button
· Click Next
· Modify docket text, if appropriate.  Click Next.
· Final Docket Text appears.  Click Next ONLY if correct.  If incorrect, click the Back button at the top of the browser screen to make the correction, or abort/restart the transaction by clicking on the Bankruptcy Events hyperlink.
· Notice of Electronic Filing screen will appear.
Withdrawal of Change of Address
· Select Bankruptcy
· Select Limited Miscellaneous Events
· Type in case number
· Click Next
· Select Withdrawal of Change of Address
· Click Next
· Click Next 
· Select attorney filing pleading or leave as is and click Next
· Select party filing pleading or Add/Create New Party
· Click Next
· Attach PDF by clicking on the Browse button
· Locate pdf document and right-click to open
· Click on Open button
· Click Next
· Click checkbox of the notice to be withdrawn
· Click Next
· Click Next
· Final Docket Text appears.  Click Next ONLY if correct.  If incorrect, click the Back button at the top of the browser screen to make the correction, or abort/restart the transaction by clicking on the Bankruptcy Events hyperlink.
· Notice of Electronic Filing screen will appear.
Withdrawal of Notice of Appearance
· Select Bankruptcy
· Select Limited Miscellaneous Events
· Type in case number
· Click Next
· Select Withdrawal of Notice of Appearance and Request for Notice
· Click Next
· Click Next
· Select attorney filing pleading or leave as is and click Next
· Select party filing pleading or Add/Create New Party
· Click Next
· Attach PDF by clicking on the Browse button
· Locate pdf document and right-click to open
· Click on Open button
· Click Next
· Click checkbox of the notice to be withdrawn
· Click Next
· Click Next
· Final Docket Text appears.  Click Next ONLY if correct.  If incorrect, click the Back button at the top of the browser screen to make the correction, or abort/restart the transaction by clicking on the Bankruptcy Events hyperlink.
· Notice of Electronic Filing screen will appear.
Certificate of Service (Use Only for Rule 3002.1 Events)
· Select Bankruptcy
· Select Limited Miscellaneous Events
· Type in case number
· Click Next
· Select Certificate of Service (Use Only for Rule 3002.1 Events)
· Click Next
· Click Next 
· Select attorney filing pleading or leave as is and click Next
· Select party filing pleading or Add/Create New Party
· Click Next
· This Certificate of Service event should be used only when relating to the Notice of Mortgage Payment Change, Notice of Postpetition Mortgage Fees, Expenses, and Charges, or the Response to Notice of Final Cure Payment.
· Click Next
· Note: no document number will be assigned
· Attach PDF by clicking on the Browse button
· Locate pdf document and right-click to open
· Click on Open button
· Click Next
· Select the filing to which this certificate of service refers, and click Next
· Select claim(s) from list, and click Next
· Modify docket text if appropriate, and click Next.
· Final Docket Text appears.  Click Next ONLY if correct.  If incorrect, click the Back button at the top of the browser screen to make the correction, or abort/restart the transaction by clicking on the Bankruptcy Events hyperlink.
· Notice of Electronic Filing screen will appear.
Reaffirmation Agreement
· Select Bankruptcy
· Select Limited Miscellaneous Events
· Type in case number
· Click Next
· Select Reaffirmation Agreement WITH Atty Affidavit or Reaffirmation Agreement WITHOUT Atty Affidavit
· Click Next
· Click Next 
· Select attorney filing pleading or leave as is and click Next
· Select party filing pleading or Add/Create New Party
· Click Next
· Attach PDF by clicking on the Browse button
· Locate pdf document and right-click to open
· Click on Open button
· Click Next
· Enter Creditor Name in this Reaffirmation Agreement.  Click Next.
· Is Attorney Affidavit Included?  Choose Yes or No from the drop-down box.  Click Next.
· Modify docket text, if appropriate.  Click Next.
· Final Docket Text appears.  Click Next ONLY if correct.  If incorrect, click the Back button at the top of the browser screen to make the correction, or abort/restart the transaction by clicking on the Bankruptcy Events hyperlink.
· Notice of Electronic Filing screen will appear.
Ballot (Chapter 11)
· Select Bankruptcy
· Select Limited Miscellaneous Events
· Enter the case number
· Click Next
· Select Ballot (Ch 11)
· Click Next
· Click Next 
· Select attorney filing pleading or leave as is and click Next
· Select party filing pleading or Add/Create New Party
· Click Next
· Attach PDF by clicking on the Browse button
· Locate pdf document and right-click to open
· Click on Open button
· Click Next
· Do you ACCEPT or REJECT the plan?  Make one selection from the list, and click Next.
· Modify docket text if appropriate, and click Next.
· Final Docket Text appears.  Click Next ONLY if correct.  If incorrect, click the Back button at the top of the browser screen to make the correction, or abort/restart the transaction by clicking on the Bankruptcy Events hyperlink.
· Notice of Electronic Filing screen will appear.

Court Calendar
The Court calendar may be viewed on the Court’s website at www.gasb.uscourts.gov.  On the Court’s Website, click Court Calendar, and select judge or trustee.  Please note: Multiple Court events may be scheduled on the same day (hearings and meetings); also, cases may be heard by an alternate judge, so check calendars for the division. The calendar can be viewed for up to 30 days in advance.  There is a 24-hour delay on the web calendar.
[image: webcal open][image: webcal detail]
Reports
When running Case Reports, Docket Reports, and Claims Activity Reports, users have the option to select the type of report, based on the criteria selected.
Cases Report
The Cases report captures activity by date/date range and can display the judge assigned, office, case type, trustee assigned, chapter, asset designation, file date, entered date, discharged date, dismissed date, converted date, closed date, split date, transferred date, reopened date, open and/or closed cases, party information, pro se cases, etc.  The date range entered cannot exceed the 31-day limit.
To view the report, select Reports from the CM/ECF main menu, then Cases.  (PACER login and password must be entered: 
 [image: ]
Select search criteria, and click “Run Report.”







Sample report:
[image: ]

Claims Register
To view the claims register, select Reports from the CM/ECF main menu, then Claims Register.  (PACER login and password must be entered)
[image: ]
Enter case number, file date range, and click “Run Report.”
Sample report:
[image: ]

Docket Report (Official case information with caption and docket entries by filed or entry date)
To view the docket report, select Query from the CM/ECF main menu, enter case information > Run Query, then click the link to Docket Report.  (PACER login and password must be entered)
[image: ]
Enter case number and select “Run Report.”
Sample report:
[image: ]
Claims Activity Report
All claims filed internally and externally are recorded on the Claims Activity Report.  It is a valuable tool in monitoring all claim filings.
To view the report, select Reports from the CM/ECF main menu, then Claims Activity Report.  (PACER login and password must be entered)
[image: ]
Enter case number, select criteria, and click “Run Report.”
Utilities
In the Utilities menu, users may maintain user’s ECF account, view user’s transaction log, and maintain user’s PACER account.


Maintain Your ECF Account 
Users can update name, mailing and email addresses, email preferences, phone number, fax number, and passwords:
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Resetting Password in CM/ECF
If you are unable to remember or locate your password for the LIVE or TRAIN systems in CM/ECF, you can reset your password online.  To reset your password, go to the CM/ECF Login page.  Click the hyperlink in the sentence that states: “If you forgot your CM/ECF password, you can request a password reset here.”  Enter your ECF login ID in the field provided, and click “Submit.”
You will receive an email from USBC_registration@gas.uscourts.gov to the email address of record for your ECF account, with a URL to change your password.  Check your spam message folder if you do not receive your reset message within 10-15 minutes.
NOTE: This is for ECF logins only.  This will not work for PACER accounts.  For a lost password on a PACER account, contact the PACER Service Center.
View Your Transaction Log
A user may view all the docketed events under his/her login and password for a specified date range:
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Email Notifications (for Attorney Users)
To set up Email notification regarding a case:
· Select Utilities from the CM/ECF main menu
· Select Maintain Your ECF Account
· Confirm the information displayed on the screen (name, address, phone number, etc.)  Update if necessary.
· Click Email Information
· Primary Email Address – confirm that the primary email address is correct
· Secondary Email Address – besides the standard email address, you may have notices sent to other email addresses (paralegals/staff may need this notification activity). If you would like email notification sent to other email addresses, click inside the text box to enter the additional email addresses.  Separate addresses with a semi-colon.
· Determine where the email notifications should be sent:
· To my primary email address:  to activate notices, this box must be checked
· To the secondary addresses:  If you would like email notification sent to other email addresses, click this box.
· Determine which cases should send the email notification:
· Send notices in cases in which I am involved:  checking this box will automatically inform you when any filing has been submitted in a case in which you are a participant.
· Send notices in these additional cases:  you do not have to be a participant in a case to receive notification of case activity.  You may elect to be notified of activity in cases you have an interest in, but in which you are not a party to the case.  If you would like to receive email notification in additional cases, click this box, and click inside the text box to enter the case number(s).  Use case number format yy-nnnnn (ex: 01-12345).
· Determine how to receive email notifications:
· Send a notice for each filing:  checking this box means you will receive email notices when activity occurs throughout the day to the account(s) specified.  The subject line of the email will describe the type of filing and include the case number.
· Send a Daily Summary Report:  A summary report includes the case numbers and titles of cases in which activity occurred on that day.  The text of the summary email notification will display the docket event and the document number(s), including the hyperlink(s).
· NOTE:  you cannot elect to receive both separate notices and the summary report.
· Determine how the email notifications should be formatted (Format Notices):
· Html format for Netscape or ISP email service.  The html format will include a hyperlink to the document.
· Text format for cc: Mail, Groupwise, or other email service.  Text format will feature the URL of the pdf document, which can be copied and pasted into the location bar of the browser.
· Save changes:  Click Return to Account Screen, then click Submit.

Your PACER Account
You can use the Utilities menu to update, review, and manage your PACER account.  Click My PACER Account.
Links will appear with options for managing your PACER account.  You can use these links to change your PACER login, account information, and view billing history.
	   CM/ECF Login
   Change Your Client Code
   Change Your PACER Account
   Review Billing History
   View PACER Account Information






Credit Card Payments/Internet Fees Due
The credit card module is designed to allow CM/ECF Filing users to pay filing fees to the U.S. Treasury via the Internet, as part of the electronic filing process.  The module offers many advantages for filing users, including the ability to:
· Receive a transaction receipt which is immediately docketed to the case
· Review internet credit card transaction payment history at any time
· Review any outstanding payments due to the Court at any time
· Make online payments of unpaid balances at any time
Filing users should have credit card information on hand at the time of electronically filing any pleading that requires a filing fee.  Filing users can choose to pay after each transaction, or make one payment at the end of the day for all transactions requiring fees.  Using either method, filing users are required to pay all incurred filing fees in CM/ECF with a credit card the same day the fee is incurred; if fees are not paid within 24 hours, a show cause order may be entered by the Court.
The system does not retain account information.  The Court accepts the following credit cards for payment:  American Express, Discover, Diner’s Club, Visa, and Mastercard.
Credit Card Payment Instructions
· Upon completion of electronically filing a pleading that requires a fee, a pop-up credit card payment window will appear, overlaying the CM/ECF Notice of Electronic Filing.  This screen contains the new filing fee charge, and any other outstanding CM/ECF filing fees for the filing user.  Select one of the options:  Pay Now or Continue Filing.
· NOTE: pop-up blocker software will prevent the Electronic Payment window from displaying, and must be disabled or uninstalled before paying fees by credit card online.

· Pay Now:  if Pay Now is selected, the filing user will be automatically connected to the U.S. Treasury site (Pay.gov).  The filing user will be prompted to “Enter Payment Information.”  The filing user’s name, first address line, and zip code will appear as shown in CM/ECF.  Please note that changing any of the address fields on the Pay.gov screen does not affect the filing user’s address as it appears in CM/ECF.
· Enter the following credit card information:
· Type of Card (Visa, Mastercard, etc.)
· Card Number
· Expiration Date
· In the field “Security Code,” filing users may enter the three digits on the back of the credit card; however, this information is not required.
· All fields marked with a red asterisk (*) are required.  Once all information has been entered, click Continue.
· If a message appears stating “Errors were found in your request,” make the required changes/enter the required information directly on this page, then click Continue.
· The “Payment and Summary Authorization” screen will appear.  You must authorize payment by clicking the box next to “I authorize a charge to my card account for the above amount in accordance with my card issuer agreement.” 
· If you wish to have a confirmation email sent to you, enter your email address in the space provided on this screen.  You may also print a transaction receipt for your records.  The transaction receipt will appear at the conclusion of the transaction.
· Once the box is checked (and email address entered, if desired), click “Make a Payment” ONCE.  Clicking this button more than once may result in multiple charges to your credit card.  If you receive the message “Duplicate Submission Detected,” please contact the Court to request a refund.  Refer to the section below on Refunds.
· If a message appears stating “Errors were found in your request,” make the required changes/enter the required information on this page, then click “Make a Payment,” taking care to click only once.
· If the credit card transaction is approved, a transaction receipt will appear with the transaction number to confirm payment.  It is recommended that you print a copy of this receipt for your records.
· Click Close Window to return to CM/ECF.
· If payment is declined, contact the card-issuing bank to determine why the card was declined.  If the issue cannot be resolved, call the Court’s main number (912) 650-4100 and speak to the financial specialist, to advise that you will be using an alternate method to pay the filing fee(s) due.  Refer to the section below on Alternate Forms of Payment.
· Continue Filing:  Selecting Continue Filing allows filing users to continue filing in CM/ECF and accumulate any filing fees incurred during the day.  This gives filing users the option of paying all filing fees at once, upon completing electronic filing for the day.  If this option is chosen, you will be returned to CM/ECF for filing.
· Upon completion of each additional filing, you will receive the pop-up credit card window on the screen, overlaying the CM/ECF Notice of Electronic Filing.  This pop-up window will contain a summary of the current charges that remain outstanding.  To close your account at any time, click “Pay Now” and proceed as instructed above.
· All accounts must be closed out (paid in full) on the same day the fee was incurred, by close of business.  If payment is not received on the day of filing, you will receive a courtesy call the following business day, indicating that your fee is outstanding and must be paid.  Failure to pay filing fees as required will result in a show cause hearing, and filing privileges suspended until all outstanding fees are paid in full.  Refer to the section below on Alternate Forms of Payment.
· You may close out your account at any time by running an “Internet Payments Due” report.  Refer to the section below on Fee Reports for more information.
Deferred/Exempt/Waived Fees
Debtor’s counsel, trustees, and other federal government filers may be exempt from certain filing fees.  If deferring/waiving a filing fee or if exempt from paying a filing fee, click “Continue Filing” when the pop-up credit card payment window appears.  CM/ECF will recognize that no filing fee is due, and allow the filing user to continue to the next screen.
Refunds
If you suspect a payment is incorrect or has been made in error, contact the Court’s financial specialist immediately via email at Wendy_Pena@gas.uscourts.gov.  Provide the case number, docket number, and the transaction/receipt number of the pleading in question.

Alternate Forms of Payment
Permission to pay filing fees by means other than credit card, when filing documents electronically, is limited to extraordinary circumstances, and is the exception rather than the rule.  Alternate forms of payment may be accepted on a case-by-case basis in limited situations, if approved in advance by the Clerk of Court.  Written requests to pay filing fees using cash, check, or money order for electronically filed documents should be emailed to the Clerk of Court at Lucinda_Rauback@gas.uscourts.gov.  
The email request should state “Request for Alternate Fee Payment” in the subject line, and include the following information:
· Case number, file date of document, type of document (i.e., motion, petition, etc.)
· Reason for request to pay with alternate form of payment
· The alternate form of payment (cash, check, money order) that the filing user will submit by close of business the following day.
CM/ECF will prompt filing users when a fee is due (yes or no).  Unless authorization has been received from the Clerk to pay by alternate method, select Yes.
Helpful Hints re: Filing Fees
· If you have any questions regarding internet credit card payment procedures, please contact the Court’s financial specialist at (912) 650-4100.  For technical problems, contact the Court’s Department of Computer Services HelpDesk at (912) 650-4201. 

Documents Filed in Error
Most errors in the CM/ECF system are relatively minor and can be resolved easily when the filing user and the Clerk’s Office staff work together.  Time is of the essence when it comes to identifying and correcting errors, in that a mistake can be compounded if not dealt with immediately.
Most Common Errors
· Incorrect, incomplete, or illegible pdf image filed
· Incorrect filing/docket event used
· Document filed in the wrong case
· Document not signed with actual signature or electronic signature “s/”
· Improper forms used for filing
· Name, alias, or address of debtor in CM/ECF does not match petition
· Required or referenced attachments are missing.
Deficiency Notices
Error notification will usually come in the form of a “Notice of Defective Pleading” entered on the docket. The notice will contain the case number, name of document filed, and the nature of the error, and will inform the Filing user if corrective action is necessary.
The nature of the corrective action needed usually depends on what type of error is identified.  Normally, you will be asked to re-file or amend the document.  There may be some instances, however, that you will be asked to withdraw the document.  For instance, withdrawing the document is usually necessary when the document is filed in the wrong case.













Appendix A: CM/ECF Glossary
· Adobe Acrobat:  application used almost universally to create and view “PDF” documents.  “Adobe” created the ‘PDF’ format.
· Attachment: an additional supporting document filed electronically with a pleading.  Proposed orders can be attachments to motions and applications.
· Automatic Email Notification: a CM/ECF feature that permits any user to receive notification of the filing of a case or document via email.  Users can choose to receive separate notifications throughout the day or an end-of-day summary.
· Browse: a Windows operation of navigating through directories via a mouse to select a specific file.
· Browser: a software program which provides a user-friendly interface allowing a user to access information and services available on the Internet.  The browser programs interpret Hypertext Markup Language (HTML) documents delivered from Web servers.
· Category: in CM/ECF, a classification of similar document types.  Category selections appear as hypertext links under the Bankruptcy and Adversary menu selections.
· CBT: a CBT (computer-based training) is an online learning application accessed over a local area network (LAN) or from a CD.  When a CBT is accessed online, it is referred to as web-based training or a WBT.
· Check Box: a control object a user can click to include choices from a list.  Check boxes are designed so that users can choose one or more items from a list.
· CM/ECF: Case Management/Electronic Filing; the Administrative Office’s application for filing cases and documents electronically via the Internet.
· Default: a common suggested value displayed by CM/ECF on a screen.  Many fields in CM/ECF have common values suggested; if correct, users may accept them, or if incorrect, may type over them.
· Document Type: In CM/ECF, a specific filing or event with similar characteristics within a case which behaves uniquely from other document types.
· Drop Down Box: a window listing selections of data alphabetically in a text box.  Drop down boxes are used throughout CM/ECF for making selections.  When you see the selection you wish to make, click it to highlight it.  To make multiple selections, hold the CTRL (control) key down when making second, third, etc. selections.
· Hypertext (HTML) Link: a URL embedded in an html (hypertext markup language) document, most often underlined.  It permits the user to move from one area (or topic) to another in a web-based program.
· MR: software modification request; the format method used in the courts by users to ask for changes in the program.  Changes can be either enhancements or the discovery of a functional program error.  
· Notice of Bankruptcy Case Filing: a CM/ECF document that is generated at case opening with all the substantive information of the case.  The Entry Date appears on the local Court seal displayed on this formal notice.  When the petition is submitted by an attorney, both the date and the time of filing appear.  This official document can be used to enforce collection and foreclosure activities of creditors.
· Notice of Electronic Filing: an electronic document produced by CM/ECF which certifies filing of all documents and claims with the U.S. Bankruptcy Court.  All parties requesting electronic notification can be sent this certification via electronic mail.
· PDF Document: a “portable document formatted” document; a type of imaged document created by Adobe Acrobat.  Each document is secured with a unique encrypted key.  All documents in CM/ECF must be in “PDF” format, with the exception of the creditor matrix, which must be uploaded in a text (.txt) format.
· Radio button: a round selection button used to choose items from a list.  Radio buttons are designed so that users can choose only one item.
· URL: Universal Resource Locator; URLs are the naming scheme used to find web pages.  A URL is similar to a street address.  The URL for the Georgia Southern Bankruptcy Court is www.gasb.uscourts.gov.


Appendix B: Common Abbreviations and Designations

	State/Possession
	Abbreviation

	Alabama
	AL

	Alaska
	AK

	American Samoa
	AS

	Arizona
	AZ

	Arkansas
	AR

	California
	CA

	Colorado
	CO

	Connecticut
	CT

	Delaware
	DE

	District of Columbia
	DC

	Federated States of Micronesia
	FM

	Florida
	FL

	Georgia
	GA

	Guam
	GU

	Hawaii
	HI

	Idaho
	ID

	Illinois
	IL

	Indiana
	IN

	Iowa
	IA

	Kansas
	KS

	Kentucky
	KY

	Louisiana
	LA

	Maine
	ME

	Marshall Islands
	MH

	Maryland
	MD

	Massachusetts
	MA

	Michigan
	MI

	Minnesota
	MN

	Mississippi
	MS

	Missouri
	MO

	Montana
	MT

	Nebraska
	NE

	Nevada
	NV

	New Hampshire
	NH

	New Jersey
	NJ

	New Mexico
	NM

	New York
	NY

	North Carolina
	NC

	State/Possession
	Abbreviation

	North Dakota
	ND

	Northern Mariana Islands
	MP

	Ohio
	OH

	Oklahoma
	OK

	Oregon
	OR

	Palau
	PW

	Pennsylvania
	PA

	Puerto Rico
	PR

	Rhode Island
	RI

	South Carolina
	SC

	South Dakota
	SD

	Tennessee
	TN

	Texas
	TX

	Utah
	UT

	Vermont
	VT

	Virgin Islands
	VI

	Virginia
	VA

	Washington
	WA

	West Virginia
	WV

	Wisconsin
	WI

	Wyoming
	WY



	Geographical Directional
	Abbreviation

	North
	N

	East
	E

	South
	S

	West
	W

	Northeast
	NE

	Southeast
	SE

	Northwest
	NW

	Southwest
	SW



	Military “State”
	Abbreviation

	Armed Forces Europe, the Middle East, and Canada
	AE

	Armed Forces Pacific
	AP

	Armed Forces Americas (except Canada)
	AA



	Primary Street Suffix Name
	Postal Service Standard Suffix Abbreviation

	ALLEY
	ALY

	ANNEX
	ANX

	AVENUE
	AVE

	BEACH
	BCH

	BEND
	BND

	BLUFF
	BLF

	BOTTOM
	BTM

	BOULEVARD
	BLVD

	BRANCH
	BR

	BRIDGE
	BRG

	BROOK
	BRK

	BYPASS
	BYP

	CAMP
	CP

	CANYON
	CYN

	CAPE
	CPE

	CAUSEWAY
	CSWY

	CENTER
	CTR

	CIRCLE
	CIR

	CLIFFS
	CLFS

	CLUB
	CLB

	COMMONS
	CMNS

	CORNER
	COR

	COURSE
	CRSE

	COURT
	CT

	COVE
	CV

	COVES
	CVS

	CREEK
	CRK

	CRESCENT
	CRES

	CREST
	CRST

	CROSSING
	XING

	CROSSROAD
	XRD

	CROSSROADS
	XRDS

	DRIVE
	DR

	ESTATE
	EST

	EXPRESSWAY
	EXPY

	EXTENSION
	EXT

	FALLS
	FLS

	FIELD
	FLD

	FORGE
	FRG

	FORT
	FT

	Primary Street Suffix Name
	Postal Service Standard Suffix Abbreviation

	FREEWAY
	FWY

	GARDENS
	GDNS

	GATEWAY
	GTWY

	GLEN
	GLN

	GREEN
	GRN

	GROVE
	GRV

	HARBOR
	HBR

	HEIGHTS
	HTS

	HIGHWAY
	HWY

	HOLLOW
	HOLW

	ISLAND
	IS

	ISLANDS
	ISS

	JUNCTION
	JCT

	LAKE
	LK

	LANDING
	LNDG

	LANE
	LN

	MEADOWS
	MDWS

	MILLS
	MLS

	MOUNT
	MT

	MOUNTAIN
	MTN

	OVERPASS
	OPAS

	PARK
	PARK

	PARKWAY
	PKWY

	PLACE
	PL

	PLAINS
	PLNS

	PLAZA
	PLZ

	POINT
	PT

	PORT
	PRT

	PRAIRIE
	PR

	ROAD
	RD

	ROUTE
	RTE

	SPRING
	SPG

	SQUARE
	SQ

	STATION
	STA

	STREET
	ST

	SUMMIT
	SMT

	TERRACE
	TER

	TRAIL
	TRL

	VALLEY
	VLY

	VILLAGE
	VLG


Secondary Unit Designators:
	Description
	Abbreviation

	Apartment
	APT

	Basement
	BSMT

	Building
	BLDG

	Department
	DEPT

	Floor
	FL

	Office
	OFC

	Penthouse
	PH

	Room
	RM

	Space
	SPC

	Suite
	STE

	Unit
	UNIT

	Upper
	UPPR
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U.S. Bankruptcy Court
Southern District of Georgia
Official Court Electronic Document Filing System
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IMPORTANT NOTICE

Pending Bankruptcy Rules and Forms Changes
Pending Changes in the Bankruptcy Forms (Effective April 1, 2016

Proposed Amendments to Federal Rules of Bankruptcy Procedure (Effective December 1, 2015)
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This facility is for Official Court Business only. Activity to and from this site is logged. Document filings on this system are subject to Federal Rule of Civil Procedure 11 and Federal Rule of

Bankruptcy Procedure 9011. Evidence of unauthorized or criminal activity will be forwarded to the appropriate law enforcement officials under 18USC 152 and 3571.
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16-10001-SDB Clarence Thomas Bentley
Case type: bk Chapter: 13 Asset: Yes Vol: v Judge: Susan D. Barrett
Date filed: 01/01/2016 Date of last filing: 03/23/2016 Plan confirmed: 03/09/2016
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For
Chief Judge Lamar W. Davis, Jr.

SAVANNAH

‘Counsel for the parfies in cach case are required fo confer prior to the scheduled hearing Following
consulfation, if counsel believes a scheduled matter will require more than 15 minutes to resolve, at the call for
seftlement announcements, counsel s to so advise the court and based upon counsel's best estimate of time
required for hearing, the matter wil be specially assigned for later hearing today or confinued to a special
assigned hearing date and time.

45 Matters On Tuesday, January 31, 2006
reet Savannah, GA 31401 Retwrn to Calendar

At 125 Bull

Slot | age Number Debtor Subject

0543310 BLEVINS, ANGELINA

FRANCO

Objection to Confirmation by Trustee;

Barid, Richard 5.
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Cases Report for 7/8/2016
U.S. Bankruptcy Court
Southern District of Georgia
Office: 1

Parly Info s Dates Other Info
Fied 07I0812016 Offce: Augusta

CaseNo
Related Case Info T

16-10915-SDB bk 13 Donna Jeanette Heard Barrett

1610916

16-10917

16-10918

16-10919

16-10920

i

bk

bk

bk

bk

bk

1

13

13

13

3

Attorney for Deblor: Angela Wiliams Seymour

Alex Corthen
‘Attorney for Debtor: Kathryn A. Brow

Barbara A Smith
Attorney for Deblor: Angela McElroy-Magruder

Neison Marel Moiina and Doris Ann Molina
Attorney for Deblor. Angela Wiliams Seymour
Attorney for Joint Deblor Angela Williams Seymour

Sheriyn Monirese Nabrit
‘Attornay for Dabtor: Dempsey Clay Ward

Brandi Lavonia Vann
Attorney for Deblor: Guy H. Seymour, Jr.

Entered. 0710812016 Assets: Yes
Fee: Instaliment
County: COLUMBIA-GA
Voluntary
Naturs of Debt: Consumer
Type of Debor Individual
Filed: 0710812016 Offce: Augusta
Entered: 0710812016 Assas: Yes
Foe: Paid
‘County: RICHMOND-GA
Voluntary
Nature of Debt: Consumer
Type of Debor:Individual
Filed: 070812016 Office: Augusta
Entered. 0710812016 Assets: Yes.
Foe: Paid
‘County: RICHMOND-GA
Voluntary
Nature of Debt: Consumer
Type of Debtor: Individual
Filed: 0710812016 Offce: Augusta
Entered. 0710812016 Asses: Yes
Fee: Installment
‘County: RICHMOND-GA
Voluntary
Natura of Dabt: Consumer
Type of Debor: Individual
Filed: 0710812016 Offce: Augusta
Enterad: 0710812016 Assats: Yes
Foe: Paid
‘County: RICHMOND-GA
Voluntary
Nature of Debt: Consumer
Type of Deblor: Individual
Filed: 0710812016 Offce: Augusta
Entered. 0710812016 Assets: No
Fee: Installment
‘County: RICHMOND-GA
Voluntary
Naturs of Debt: Consumer
Type of Debor Individual
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Southern District of Georgia
Claims Register

16-10013-SDB Saraya Lynn Caillier
Judge: Susan D. Barrett  Chapter: 13

Office: Augusta Last Date to file claims: 05022016
Trustee: Huon Le Last Date to file (Govt): 07/05/2016

Crodior. (6643445) Claim No: 1 Status:

Fiagship Credit Accetpance Original Filed Date: 011082016 Filed by: CR

P.0_Box 3607 Original Entered Date: 01/08/2016 Entered by: admin

Coppel, TX 75013 Modied:

Amount claimed: $27478.27
Secured claimed: $27478.27

History:
Detals @ 1 O1/082016 Claim #1 fled by Flagship Credit Accetpance, Amount claimed: $27478 27 (admin)

Descrption

Remarks: (1-1) Account Number (last 4 digits} 3811

Credior. _ _(6645098) Claim No: 2 Status:

SPRINGLEAF FINANCIAL SERVICES, INC. Original Filed Date: 0111212016, Filed by: CR

P.0.BOX 3251 Onginal Entered Date: 01/1212016 Entered by: Sarah Hoffman
EVANSVILLE, IN 47731 Modfied:

Amount claimed: $4227 57
Secured claimed: $4227 57

History:
Detals @ 24 O1/1272016 Claim #2 fled by SPRINGLEAF FINANCIAL SERVICES, INC., Amount claimed: $4227 57 (Hoffman, Sarah )
Description:
Remarks:
Creditor. (6646033) Claim No: 3 Status.
OMNI FINANCIAL Original Filed Date: 011132016 Filed by: CR
PO BOX 53628 Oniginal Entered Date: 01/13/2016 Entered by: Michael Wison McCollum
FAYETTEVILLE, NC 26305 Modified:
Amount claimed: $4591 37
History

Dotals @ 34 O1/13/2016 Claim #3 fled by OMNI FINANCIAL, Amount claimed: $4591.37 (McCollum, Michas! )
Description: (3-1) MONEY LOANED
Remarks:

Creditor. (6641452) Claim No: 4 Status.
JONES-ONSLOW EMC Original Filed Date: 0111912016 Filed by: CR

259 WESTERN BOULEVARD Original Entered Date: 01/19/2016 Entered by: Lenaann Casalino
JACKSONVILLE NC 28546 Modifed:

Amount claimart $266 4
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4 Associated Cases

U.S. Bankruptey Court
Southern District of Georgia (Augusta)
Bankruptcy Petition #: 16-10013-SDB

Tnternal Use Only
Date fled: 0110512016
Assigned to: Susan D Barrett 341 meating: 02182016
Chapter 13 Deadline for iling claims: 05022016
Voluntary Deadline for filing claims (govt,): 07/05/2016
Asset
Claims Register
Debior represented by Matthew James Duncan
Saraya Lynn Caillier Matthew James Duncan, Attomey at Law
1921 Garcia Drive 266 Greene Strect
Apartment D Augusta, GA 30901
Augusta, GA 30905 706-755-2928
RICHMOND-GA Fax 1066640407
SSN/ ITIN: 445-02-3811 Email: matthew james duncan@gmail com
fka Saraya Lynn Strong
Trustee represented by Huon Le
Huon Le PO Box2127
P.0. Box 2127 Augusta, GA 30903
Augusta, GA 30903 706-724-1039
706-724-1039 ‘Email: notices @chp! 3aug otz
Filing Date # Docket Text
01/052016 @1 | Chapter 13 Voluatary Petition Individual . Fee Amount $0. Filed by Saraya Lynn Caillier (Duncan, Matthew) (Entered: 01/05/2016)
01/052016 @2 | Chapter 13 Plan Filed by Matthew James Duncan on behalf of Saraya Lynn Caillier. (Duncan, Matthew) (Entered: 01/05/2016)
@3 | Bankmuptcy Form 121 SSN. DOCUMENT IMAGE AVAILABLE ONLY TO COURT USERS. Filed by Matthew James Duncan on behalf of Saraya Lyna

011052016 Caillier (Duncan, Matthew) (Entered: 01/05/2016)

@3 | Application to Pay Fiing Fee in Installments Filed by Mathew James Duncan on behalf of Saraya Lynn Callier. Filing Fee due by 05412016, (Duncan,
01/052016 Matthew) (Entered: 01/05/2016)

01/052016 @5 | Centficate of Credit Counseling Filed by Matthew James Duncan on behalf of Saraya Lynn Caillier (Duncan, Matthers) (Entered: 01/05/2016)

01052016 @6 | Employee Income Records Filed by Matthew James Duncan on behalf of Saraya Lynn Caillier (Duncan, Matthew) (Entered: 01/05/2016)

@7 | Meeting of Creditors 341(a) meeting to be held on 2/2/2016 at 03:00 PM at Augusta Mectings - New. Proofs of Claims due by 5/2/2016. Government Proof
of Claim due by 7/5/2016. Confirmation hearing to be held on 2/29/2016 at 03:30 PM at AUG Hearings - Plaza Bldg. Last day to oppose discharge or
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127 [ 082512005 092639 | 1056k 10027 Moton to Recomsder <Ii<> Fled by Debtor Mikey Movse (Relted docaens (2]) (Bena, Weads)
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25149 | 0812512005 100525 | 1-05-bk-10027 Amendment Fed by Debtor Mickey Mouse (KE: related document(:)[9] ). (Bena, Wends)
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